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AGENDA

Networking (11:30am - 12:00pm)
Program (12:00pm — 1:00pm)
Introduction to AIM 2024 Health R&D Summit
Patti Geppert, PhD - SAMMI Director VelocityTX
Naval Medical Research Unit- San Antonio Brief
CDR Rachel Werner DDS, PhD - Acting Chief Science Director
Brooke Army Medical Center Brief
Joseph Maddry, MD- Chief, Department of Clinical Investigation

Department of Veteran’'s Affairs Brief
Alicia Swan, PhD- Director of Rehabilitation Research

Q&A and Closing w

VELOCITY. TX



Military Medical Industry Day
IV

Full-Day Conference
« 335+ Attendees
* 50+ Companies

Three Pre-Event Symposiums
e 75+ Attendees

Focus on private-sector
collaboration

L1V TR BEXARBID

Pitch Competition

100+ Attendees
48 Applicants
o 13 States

. 1 International

12 advanced to semi-final round

4 finalists selected to present at
BexarBio

SURF

San Antonio Military Health
and University Research Forum

Full-Day Research Forum:
300+ Attendees

Researchers from:

* Military

 Academia

* Nonprofit Research
Institutes

e Industry



Military End User @
VELOCITY. TX

Industry DevelopmentgI&E, V&V Laboratory*/Academia

* AFWERX calls “customers” for SBIR/STTR



LEVERAGING AIM: UNDERSTAND DOD MEDICAL REQUIREMENTS

 Attend podium and poster presentations by researchers
* 12 one-hour podium sessions
» 60+ research posters over two days

* Listen to panels on the vision for DoD medical product
development and DHA portfolio managers

 Talk to researchers and end-users from Army, Air Force, Navy,
BAMC and Veteran's Affairs at 10-minute one-on-one pitch
sessions.

« Sign-up for 10 minute time slots on day of meeting

f

VELOCITY. TX



LEVERAGING AIM: ONE-ON-ONE SESSIONS TOPIC AREAS

* Blood and Shock Resuscitation ¢ Combat Wound Care

° Hemorrhage and Edema Control ° InfeCtion/SepSiS: d_iagnOSiS,
_ _ treatment, prevention
- Battlefield Pain Management « Burns: assessment and treatment
* Traumatic Brain Injury » Military Medical
Polytrauma Related Simulation/Education/Training
* Engineering/Automation « Rehabilitation
Technolo_gy .  Patient Safety
* Bioengineering _
+ 3D printing » Healthcare Operations
« Dental/Maxillofacial Injury and
Surgery R&D w

VELOCITY. TX



LEVERAGING AIM: LEARN HOW TO COLLABORATE

e Learn how to:

 collaborate with researchers for product development
* sell to the DHA and VA
 find end-users for your medical products

 Learn how to fund your research and product development
 Grants and contracts
« Congressional Special Interest
« Consortium OTA's
- SBIR/STTR
« Angel Investors and Venture Capital

» See Innovative dual-use medical technology
* Networking

f
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MAY 1, 2023
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UPCOMING PRE-MEETING WEBINARS

MAY 20, 2024

Mechanisms
for Collaboration, Technology Transfer, and
Commercialization with the Military

Introduction to military technology transfer
mechanisms that will be discussed in detail at the
AIM 2024: Health R&D Summit

Scan to go to the
AIM 2024 Pre-Event Webinar Webpage
Registration open soon for future events

f

VELOCITY. TX



PAST PRE-MEETING WEBINARS CRECORDINGS)

« Requlatory Strategy- Importance of FDA Interactions (2023)
* Licensing Technologies from the Military (2023)

« Mechanisms for Private Sector Collaborations with Military
Teams (2023)

 Keys to Collaborating with the Military (2022)

 Military Medical Needs, Requirements and Funding (2022)
* Tales from the Field (2022)

https://www.velocitytx.org/support/sammi/ w
VELOCITY.TX



OFFICE HOURS AT VELOCITYTX:
US ARMY INSTITUTE FOR SURGICAL RESEARCH

Friday 11:00am — 1:00pm CT

Dual-Use Topic Areas of Interest include:
« Medical Al technologies

« Clinical decision support systems and advanced display technologies

« Advanced physiologic sensors and monitoring

» Medical robotics and automation

- Advanced medical imaging

« Organ support technologies

 Devices for critical care in the battlefield w

Contact Patti Geppert for more information: patti@velocitytx.org

VELOCITY. TX



Naval Medical Research Unit San Antonio
Command Brief

Rachel L. Werner, DDS, MS, PhD
CDR, DC, USN
Acting Chief Science Director
22 April 2024

READINESS THROUGH RESEARCH & DEVELOPMENT



Mission

Conduct gap-driven combat casualty care, craniofacial, and directed enerqgy research to
improve survival, operational readiness, and safety of Department of Defense personnel
engaged in routine and expeditionary operations.

UNITED STATES OF N

READINESS THROUGH RESEARCH & DEVELOPMENT
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Facilities

Battlefield Health and Trauma Tri-Service Research Laboratory
Research Institute

NAMRU-SA shares the BHT with the US NAMRU-SA also shares joint facilities at
Army Institute of Surgical Research and TSRL with the US Air Force 711t Human

the US Air Force Dental Evaluation and Performance Wing
Consulting Service

READINESS THROUGH RESEARCH & DEVELOPMENT




Scope of Research

NAMRU-SA scientists conduct basic, applied, and advanced
technology research and development

From Bench to Bedside

READINESS THROUGH RESEARCH & DEVELOPMENT



OPNAV

Chief of Naval Operations
Washington, D.C.

BUMED

Bureau of Medicine
and Surgery
Washington, D.C.

NMFP

Naval Medical
Forces Pacific
San Diego, CA

NMRC

Naval Medical
Research Command
Silver Spring, MD

[ |
NAMRU-D NSMRL NHRC o8l NAMRU-SA
Naval Medical Naval Submarine Naval Health : Naval Medical
Research Unit-D Wteslteel Reseeeli Lals Resea!'ch Center ‘48 Research Unit-SA
Dayton, OH Groton, CT = San D/eqo, CA g San Antonio, TX
NMRC-IP NAMRU-E NAMRU-S

Naval Medical ;
Research Unit EUR °
Sigonella, Italy

Naval Medical
Research Unit- South §
Lima, Peru :

Naval Medical
Research Center-
Indo Pacific

READINESS THROUGH RESEARCH & DEVELOPMENT




Command Directorates & Departments

Science
O Combat Casualty Care and Operational Medicine d Veterinary Sciences
= Biomedical Systems Engineering and Evaluation = Veterinary Research

» Cellular and Immune Based Adjuncts For Casualty Care
= Expeditionary and Trauma Medicine o ] ]
Administrative Operations &

U Directed Energy Health Effects Resource Management
» [ aser Health Effects

= FElectromagnetic Health Effects 0 Administrative Operations

= Health Effects Modeling and Simulation »  Administrative Operations

» High Reliability Operations
U Craniofacial Health and Restorative Medicine

= Bjomaterials 0 Resource Management
= Epidemiology = Acquisitions & Procurement
» Environmental Surveillance = Materials Management

» Maxillofacial Injury and Disease
NAMRU-SA Staff

Military: 20, Civilian: 28, Contractor: 57 ORISE/Interns: 8

READINESS THROUGH RESEARCH & DEVELOPMENT




1 Combat Casualty Care and Operational Medicine

+ Biomedical Systems Engineering and Evaluation

Imaging systems to visualize the distribution of blood in dental pulp and assess
pulp vitality

Use of machine learning algorithms to improve combat casualty care

Testing and improvement of various devices Ozone Field Sterilizer
* Tourniquets

« Endotracheal tubes R

* Field sterilizer Blood/IV Fluid Inciduars

Arterial
Waveform

Polar medicine research

Summer Weight
Clothing

Exposed SKin

\_ Cemponsatery Raserve= 0%

READINESS THROUGH RESEARCH & DEVELOPMENT




NAMRU-SA Medical Research Programs

1 Combat Casualty Care and Operational Medicine

* Cellular and Immune Based Adjuncts for Casualty Care

» Evaluation of the regenerative potential of stem cells and other biologics in combination with novel
polymer scaffolds for critical size bone defects

» Development of 2D and 3D cell-based platforms to rapidly screen for novel therapeutics in the treatment
of shipboard casualties

» Use of in vitro model of endotheliopathy to validate efficacy of newly-developed blood products for
treatment of hemorrhagic shock

In Vitro Human Skin Organ-on-a-Chip / Organoid /
3D Tissue culture

Rapid Screening and
Models of Injury

. . Surrogates
MicroCT Analysis of Bone

Immunohistochemistry Regeneration in Rat Model of
Calvarial Defect

https://www.mattek.com ' ﬁitﬁs}_//gv_idi_nt;iotech.com/ The Wyss Institute, Harvard University

READINESS THROUGH RESEARCH & DEVELOPMENT *




NAMRU-SA Medical Research Programs

1 Combat Casualty Care and Operational Medicine

+ Expeditionary and Trauma Medicine
* DoD's only polytrauma hemorrhage model

« Conduct investigation of multi-function resuscitation fluids and other blood analogues for use in
prolonged care scenarios

» Conduct investigation of maritime and shipboard hemorrhage control
« REBOA and adjunct treatment strategies
» Expand duration and indication of use for XSTAT

XSTAT

https://prytimemedical.com

ESS THROUGH RESEARCH & DEVELOPMENT

https://hbo2therapeutics.com/



NAMRU-SA Medical Research Programs

1 Directed Energy Health Effects
 Medical Laser Health Effects

« Investigation of the health effects of laser injuries expected in the use of high-energy laser systems

« Development of the mechanistic understanding of laser injuries to develop diagnoses, treatment plans,
and clinical practice guidelines for battlefield, en route, and prolonged care scenarios

« Investigation of triage efforts for laser injuries on the battlefield
« Development and testing of laser countermeasures
« Establish novel safety standards for DoD training and operational environments

United States Navy Photo(s)

READINESS THROUGH RESEARCH & DEVELOPMENT
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NAMRU-SA Medical Research Programs

1 Directed Energy Health Effects

» Electromagnetic Field (EMF) Health Effects
» Investigation of the Health Effects of EMF, electrical current, and acoustic energy injuries

» Development of the mechanistic understanding of EMF injuries to develop diagnoses, treatment plans,
and clinical practice guidelines for battlefield, en route, and prolonged care scenarios

» Investigation of triage efforts for EMF injuries on the battlefield
» Development and testing of EMF countermeasures

Establish novel safety standards for DoD training and operational environments



NAMRU-SA Medical Research Programs

d Directed Energy Health Effects

* Medical Modeling and Simulation of Directed Energy Health Effects
» Development of medical predictive models of DE injuries
* Model and predict wound severity and treatment options for DE injuries

dishes, plates, wells

» extracellular adhesive
proteins

= cell-cell interactions
= extracellular proteins

= cell-induced extracellular
remodeling

= organoid technology

* microfabrication of
dedicated compartments

» microfluidic circulation
of media

muscle

liver
bone marrow
kidney <~

qut”

https://fda.gov
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NAMRU-SA Medical Research Programs

O Craniofacial Health and Restorative Medicine
 Biomaterials
« Development of electrospun 3D collagen-based nanofibrous scaffolds for craniofacial
surgery

« Development of novel bioprinted microneedle hydrogel dressings for delivery of
customizable therapeutics

« Development and evaluation of self-healing composite dental restorative material with
increased longevity to reduce dental emergencies occurring during deployments

» Investigation of effects of extreme environments on the integrity of dental and Electrospun scaffolds
pharmaceuticals as well as on the providers and procedures for administration : s (63

Loaded hydrogel dressing
s




NAMRU-SA Medical Research Programs

 Craniofacial Health and Restorative Medicine
« Epidemiology
» Investigation of medical evacuations related to dental emergencies and maxillofacial traumatic injuries

» Investigation of dental emergencies and individual medical/dental readiness criteria for process
improvement and improved clinical practice guidelines

The Burden of Dental Emergencies, Oral-Maxillofacial, and
Cranio-Maxillofacial Injuries in US Military Personnel

Laura Lee*; LT Noel Dickens, DC, USN*; COL Timothy Mitchener, DC, USAT, Iram Qureshi*;
Sylvain Cardin*; John Simecek*

United States Navy Photo(s)

READINESS THROUGH RESEARCH & DEVELOPMENT




NAMRU-SA Medical Research Programs

 Craniofacial Health and Restorative Medicine
« Environmental Surveillance

« NAMRU-SA is the Navy’s designated agent for mercury abatement

» Development and evaluation of Environmental Protection Agency (EPA)-compliant amalgam separation
systems

» Evaluation of dental line cleaners and treatments for heavy metals solubility via inductively coupled mass
spectroscopy

READINESS THROUGH RESEARCH & DEVELOPMENT




NAMRU-SA Medical Research Programs

1 Craniofacial Health and Restorative Medicine

« Maxillofacial Injury and Disease
» Development of novel therapeutics targeting fungal biofilms
» Evaluation of nanopatrticle-targeted laser therapy against antibiotic-resistant biofilm infections

« Engineered phage technology for treatment and detection of craniofacial diseases, snakebite envenomation, and
casualty care

pis USKLAOCKIS? _CTL Targeted laser therapy synergistically enhances efficacy of antibiotics
3% 1% 3% 3% . . .
= against multi-drug resistant Staphylococcus aureus and Pseudomonas
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EI Vetermary Sciences
Support all Navy protocols

» Support Air Force protocols (59th Medical Wing and & 711th Air Force Human Performance Wing)
« Support the Army Nurse Anesthetist training program
» Casualty care protocol for working dogs

READINESS THROUGH RESEARCH & DEVELOPMENT



Resource Sponsors

Bureau of Medicine
and Surgery

Coordination with Key
Stakeholders
(COCOMs and Navy
Component Commands)

NORTHCOM
PACOM
EUCOM

AFRICOM
CENTCOM
SOUTHCOM

USFF
PACFLT
NAVEUR
NAVAF
NAVCENT
NAVSOUTH
usmcC




Naval Medical Research Unit San Antonio Collaborations

Arquos Medical, Inc. University of lowa U.S. Naval Medical Research .
SteriO3 LLC ® University of California Davis? fowa City, IA ® Unit - EURAFCENT ° Ehsit- N mlgoMPe:Ic(::l?lgeseamh
Steadman Philippon Research San Francisco/Davis, CA Sigonella, Italy Bangkok, Thailand (AFRIMS)
Institute University of Pittsburgh|Medical gKOK,
Broomfield/Vail, CO ® Center
Stemnion @ U:-S. Naval Medical Research
Naval Medical Research Unit — Dayto Pittsburgh, PA Unit — INDO PACIFIC
711th Human Performance Wing/RHDV Uriversity of Aristeia "-\3ﬁ Hanoi, Vietnam
P Oslo, N i
Montana . _Uslo, Norway MediWound
Air Force Research Laboratory Missoula, MT 41 eI R rch Wilimgton, DE )
Wright-Patterson AFB, OH L:bc;::tor;searc Smith & Nephew o U-S. Naval Medical Research
Naval Health R h e London, UK Unit — INDO PACIFIC
ava’ Health Researc Massachusetts Phnom Penh, Cambodia
ﬁenter _ Institute of _e Fairjourney Biologics
anocomposix :
San Die Op CA Brl_gham Young y Tec.:hnol.ogy _r S S O U.S. Naval Medical Research
: University . University of . ® Unit- INDO PACIFIC
Provo. U i ) U.S. Naval Medical Research Si
: , Center v Unit — EURAFCENT ingapore
Grotong, CT/Cambridge, falf 0, Egyp:
MA/Storrs, CT
@ ’ » &
University of Texas at Arlington EXII:ISA J‘\' IntoMede Co., Ltd
University of Texas at Dallas ® L Office of Naval R h ’ .‘\ Changwon, South Korea
Texas A&M University at Kingsville i i Ice of Naval Resear( n ' (= ] ;,,'I
Texas A&M University College Station Georgia Institute of Technology University of Maryland| |% % \
Texas Tech University University of Georgia Joint Program ] o X
University of Texas Health Science Center Atlanta/Athens, GA 2,5,6) U.S. Naval Medical Research
University of Texas at San Antonio Unit — EURAFCENT
Air Force Postgraduate Dental School @ Camp Lemonnier, Djibouti James Cook University
Fort Worth Water . . - -
Austin Water gnsu El;\gb_l\lfl:dmal Research Forces Institute of U.S. Naval Medical Research Townsville, Australia
Omega Optics Inc. Comayagua, Honduras ;ed_nelraRtnve Me:n;me Unit - EURAFCENT
Evolution Biotechnologies ’ pdical Researc Lynch Biologics  Accra, Ghana
M _ Deyelopment C9mmand St Jude Children's
Rochal Industries LLP gst Nas\gallj_l\;l:dlcal Research Bn!form'ttad Sfetr';ncﬁs It Research Hospital Grand Valley State
BioBridge Global i gniversity of the Hea T Franklin/Memphis, TN University
University of Texas Health Science Center ima, Peru @ Emznt;e | Neuro_Fx ) ) .
University of Texas at San Antonio mhody, n¢ Wake Forest University ~ Washington University St. o GOV/M | I |ta ry
59th Medical Wing DEMDIA ®  Winston-Salem, NC lc-;':t_"ss Universi
Air Force Dental Evaluation & Consultation Service . io State University H
([ . . °
Army Graduate Program in Anesthesia Nursing ?Z;r:;m;:zgmar Army TAC é;lefda'le/,CMll/IncZJlanagﬁls/ ACadem 1a
- . . Louis/Columbus,
Army Institute of Surgical Research SynDaver Laboratories Leavenworth, KS ° I nd UStry

Brooke Army Medical Center Tampa/Orlando, FL
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Brooke Army Medical Center
Department of Clinical Investigation
Col Joseph Maddry, MD oo

CUI Category:
LDC/DISTRO
POC:



Presenter Notes
Presentation Notes
Welcome to the new DHA PowerPoint template. Each slide contains helpful information for making the entire presentation user-friendly and accessible to people of all abilities. 

Please note: if your presentation is being presented online, the PowerPoint file must be converted and remediated as a PDF.

A NOTE ABOUT CONTROL MARKINGS: Once you determine if your presentation needs security markings, please delete the irrelevant marking and re-center the box. This marking should be in the top center of each slide. To put it in the same place ever time, simply copy (Ctrl + C) from one slide and paste (Ctrl + V) on the next slide. There is no need to position a cursor to have it paste in the correct location. 


Accessibility Note: 
How to convert a PPT to PDF properly and ensuring accessibility fixes are preserved�[Select File > Export > Click ‘Create PDF/XPS Document’ > select ‘Create PDF/XPS’ > Choose location to save file to > Click ‘Publish’]
Please be advised, once a PowerPoint file is converted to a PDF, further accessibility testing is required to make document 508 compliant.

Check out the following Microsoft page to learn more about making your PowerPoint Accessible: Make your PowerPoint presentations accessible to people with disabilities - Microsoft Support
Please contact the Section 508 PMO (dha.ncr.j-6.mbx.dhasection508pmo@health.mil) to request additional resources. 




CUI 33

Disclaimer

* The views expressed in this presentation are those of the author
and do not necessarily reflect the official policy or position of the

Defense Health Agency, Department of Defense, nor the U.S.
Government.

Improving Health and Building Readiness. Anytime, Anywhere — Always
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Clinical Investigation

An organized inquiry into and possible development of knowledge or products
related to clinical health problems for any conditions of concern in providing
healthcare to the beneficiaries of the MHS including active duty personnel,
dependents, and retired personnel. Cls represent a special category of
healthcare research. Cls are intended to improve quality of medical, dental,
nursing and allied health science care provided to beneficiaries of DoD health
services or support the graduate health sciences education (GHSE)
programs, other allied health programs of the Military Services, and
Uniformed Services University of the Health Sciences (USUHS).

Improving Health and Building Readiness. Anytime, Anywhere — Always
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CIP Branch Functions

* Management Support - alignment
fimi with DHA and GME requirements

N * Policy Support - related DoDI and
! DHA-PI

o ffione * Process Support - standardization of
\; " Finctions CIP practices

Contracting ¥ ° Resource Support - scope and

(el * Contracting Support - local needs

Resource Support

Clinical
Investigations

Improving Health and Building Readiness. Anytime, Anywhere — Always


Presenter Notes
Presentation Notes
CIP Branch Functions
The CIP Branch operates under five functional areas
Management Support – Ensuring alignment of MTF CIPs with DHA strategic drivers and MTF graduate medical education program director requirements
Policy Support – Executing policies and procedures required in key CIP-related Department of Defense instructions
Process Support – Promoting standardization of CIP practices
Resource Support –  Advocating for the necessary scope, staffing, and resources for CIPs at each MTF
Contracting Support – Developing support contracts for MTF CIPs based on their organizational needs and changes





CUI

CIP Branch Sites

Madigan Army Medical Center
loint Base Lewis-McChord, WA@ WA

MT ND
OR MM
D
sD WI

David Grant Medical Center wh
Travis Air Force Base, CA

@ US Air Force Academy, Life IA

MY

Science Research Center, CO =

uT @ =

CA co
Mike O'Callaghan Military Medical Center =

MO
Mellis Air Force Base, NV

Maval Medical Center @

? Ok
San Diego, CA AZ MM

AR
Carl R. Darnall Army Medical

- Center, Ft. Cavazos, TX
William Beaumant Army

Medical Center, Ft. Bliss, TK@ @ ™

Tripler Army Medical
HI Center, Honolulu, HI

Division, loint Base San Antonio-
Lackland, TX

Brooke Army Medical Center

loint Base San Antonio-Fort Sam
Houston, TX

Womack Army Medical ._w
Center, Ft. Liberty, NC
M

S )
Keesler Medical Center FL
Wilford Hall, 59th Clinical Research l

36

United States Military Academy,
West Point, MY

ME

Wright-Patterson Medical
Center, Wright-Patterson Air | MT

Walter Reed Mat'l
Force Base, OH i 5
MY NH Military Medical Center
* MA  Bethesda, MD
b ®)
RI
Alexander T. Augusta
IM 21 @,—f"". Military Medical Center,
WV C Ft. Belvoir, VA
WA
KXY

Mawval Medical Center
Portsmouth, VA

Maval Medical Center
- o~ Camp Lejeune, NC

Dwight D. Eisenhower Army Medical Center
Fort Gordon, GA

Keesler Air Force Base, MS

Improving Health and Building Readiness. Anytime, Anywhere — Always
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Where might I be stationed if I go to a DCI position?
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CIP Funding

* Where does funding come from?
* DHP O&M funds
= Funds civilian staff positions

= Procurement funds to purchase equipment as applicable - a
Process.

* Clinical Investigations may be conducted with grant funding from
other federal agencies or non-federal sources as permissible

Improving Health and Building Readiness. Anytime, Anywhere — Always
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Presentation Notes

CIP is funded with DHP O&M funds and may have procurement funds for purchase of equipment as applicable. The CIP may receive DHP RDT&E funding for CIs on health problems encountered by DoD eligible beneficiaries if such investigations are in support of human clinical trials in the DHP RDT&E research areas.
The CIP may receive funding on a case by case basis from non-DHP research funds in accordance with applicable federal laws and written agreements with the non-DHP sponsor.
CIs may be conducted with funds obtained by grants from another federal agency or other non-federal sources as permissible by law and federal regulations.
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Department of Clinical Investigation (DCI)

A stand-alone hospital department
Chief — Army billet, 61 series (physician)

Mission Statement: to promote, coordinate, support and oversee
organized scientific inquiry in basic, translational, and clinical research at
Brooke Army Medical Center (BAMC) and foster collaboration with other
institutions in the Region. DCI facilitates and supports the entire process
of research approval including research proposal preparation, submission,
review, monitoring, funding and contract management of approved
research, by providing program administration, education and
consultation for all research activities at Brooke Army Medical Center and
other Military Treatment Facilities and clinics covered under its
Assurances

Improving Health and Building Readiness. Anytime, Anywhere — Always


Presenter Notes
Presentation Notes
Similar to the department more of you are familiar with: Department of Pathology

Mission: The Department of Clinical Investigation (DCI) mission is to promote, coordinate, support and oversee organized scientific inquiry in basic, translational, and clinical research at Brooke Army Medical Center (BAMC) and foster collaboration with other institutions in the Region. DCI facilitates and supports the entire process of research approval including research proposal preparation, submission, review, monitoring, funding and contract management of approved research, by providing program administration, education and consultation for all research activities at Brooke Army Medical Center and other Military Treatment Facilities and clinics covered under its Assurances
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Presenter Notes
Presentation Notes
Research?? Where do I go???

To DCI, we can assist and direct you to the right experts for your project.
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BAMC DCI - Collaborations

®* The San Antonio Market has a
robust life science/medical
research community

Velocity Texas

BiomedSA

Southwest Research
Institute

UT Health
Military sites:
= 59th CIRS/WHASC

= BAMC/CFI/USAISR
= MEDCoE

ok wWbhpE

Improving Health and Building Readiness. Anytime, Anywhere — Always
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Presentation Notes
Velocity Texas is an innovation incubator
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BAMC DCI - Policy Responsibilities

* Department of Clinical Investigation is the proponent of 4 hospital

policies:
1. CIP Policy
2. Cadaver Use
3. Scientific Review
4. Reimbursement

Improving Health and Building Readiness. Anytime, Anywhere — Always
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Presentation Notes
1. CIP Policy DHA PI 3200.02 (Clinical Investigation Programs in Military Treatment Facilities) DoDI 6000.08 (Defense Health Program Research & CIPs)
2. Reimbursement DHA TM 3200.01 (Reimbursement of Research-Related Expenses for Clinical Investigations in Military Medical Treatment Facilities)
3. Cadaver Use DHA PI 6000.xx DRAFT (Sec Army signed a Memo in 2019 to hold until new DHA policy is finalized)
4. Scientific Review Policy DHA TM 3200.02 (Scientific Review of Clinical Investigations in Military Medical Treatment Facilities)
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Research Priorities - how do we execute them?

®* Support GHSE ®* Support Trauma mission
= | eadership attend MSEC, =  Re-prioritizing acquisition of
GMEC and other executive broad-use equipment.
committees in the hospital. = Moving away from highly
= Statistician rounds in all specialized, highly technical,
departments to provide Al-driven modeling and
advice. bioinformatics contracts.

= Compiled rosters of clinical
research coordinators for all
hospital departments.

Improving Health and Building Readiness. Anytime, Anywhere — Always
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The column slide is good for comparisons, for newspaper-style content, or to place an image next to text. 
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Questions?

Thank you!
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Disclaimers

® This material is the result of work supported with resources and the use
of facilities at the South Texas Healthcare System, Audie L. Murphy
Medical Center, PM&R/Polytrauma Service.

® The contents or opinions presented do not represent the views of the
U.S. Department of Veterans Affairs or any other Federal Agency of the
United States Government.

* Authors have no conflicts of interest to report.

U.S. Department of Veterans Affairs



Strategic Research Priorities at the VA

® Increase Veterans’ access to high-quality clinical trials

* Increase the substantial real-world impact of VA research

® Put VA data to work for Veterans

* Actively promote diversity, equity, and inclusion within our sphere of influence

U.S. Department of Veterans Affairs



VA Research hy the Numbers

(For Fiscal 2023)

ﬁ.'_;_ _
[ = ¢ o = L]
I ' oo
| Published research articles " : .
S A W authored or co-authored e -
Active research by VA investigators Total congressional
sites nationwide 11,107 appropriation for VA medical
105 and prosthetic research
$916M
® | —

Active funded

Active funded research projects principal investigators Total research budget

{including VA funding and other sources) 3' 774 {including other VA and non-VA sources, such as NIH)

7,431 $2.3B

Infegraphic by YA Reseanch Communications, November 2023 lsstratiors: € iStock/Olena Chernenka, Andirew_rybalka, all_is_maqic, secame, Misha Shulkenpch.




Under Secretary
for Health

Assistant Under Secretary for
Health, Discovery, Education
and Affiliate Networks (DEAN)

Chief Research and
Development Officer

Rachel Ramoni, D.M.D., 5¢.D
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VA Funding Opportunities

‘Service’

to

‘Actively Managed
Portfolios” (AMPs)

Biomedical

Suicide

Pain/Opioid

U.S. Department of Veterans Affairs

Health
Service

Clinical

Oncology Gulf War

-/

Psychedelic
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Things You Should Know

® Can | be an investigator on a study at the VA?

e Yes, however...

« VA employees have fewer barriers; non-employees effectively need to become volunteers
who go through the administrative equivalent of being hired by the VA

« In order to apply for VA funding as a Pl, one must have a 5/8ths VA appointment
(employment)

U.S. Department of Veterans Affairs



Things You Should Know

® | have a study and want to recruit Veterans. Can | do that at the VA?

e Yes, however...
« Know that recruitment-only protocols are rare
» You can request to have a study flyer posted, but it must include a Non-VA disclaimer in a
process overseen by the Office of Public Affairs
« Well articulated partnerships with VA clinical/research partners tend to fare the best

U.S. Department of Veterans Affairs



Things You Should Know

* | have science friends who want to work on VA project with me. Is that
allowed?

e Yes, however...

« Be aware that the VA takes Privacy, Data Security, and Human Subjects protections very
seriously (read: stricter rules, more administration)

« Data sharing can require a legal agreement be executed between institutions

U.S. Department of Veterans Affairs



Things You Should Know

* My company wants to partner with the VA for Research. Can we do that?

e Yes, however...

« Be aware that the VA cannot directly participate. Instead, the nonprofit corporation
(FAVHR) administrates extramural (i.e., non-VA) research funding

« You'll still want to find a clinical/research partner at the VA, but we want you to find them,

so just reach out
» Plan/act early and often as administration can sometimes be more protracted than in other

sectors

U.S. Department of Veterans Affairs



* Regulatory/Oversight
e IRB (UTHSCSA*)
e IACUC (STVHCS)
e R&D service (STVHCS)

' FAVH R

Foundation for Advanci g Veterans’ Health Research

® |nstitutional Partners

e Non-profit
corporation (FAVHR) ‘UT Health
o Affiliate University Y San Antonio
(UTHSCSA)

U.S. Department of Veterans Affairs



Where do | start?

® Research & Development
(R&D) Service

e Chief: Amrita Kamat, PhD
Amrita.Kamat@va.gov

e Human Research Director: . @ ”
Alicia Swan, PhD i

(&
Alicia.Swan@va.gov ‘*‘ |
» FAVHR | e W
You son of a yIkmin! /

e CEO: Michelle Trimble, MBA
e Michelle.trimble@favhr.org

U.S. Department of Veterans Affairs
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